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Get a Handle on Lettering 
Author: Janie Lantz 

 

PREMIER+™ 2 Embroidery Software  

Today’s lesson is designed to get you outside the box with 
your Lettering. 

Let’s explore some techniques to design Lettering that really works for you!  Expand 
your knowledge of Letter functionality with its diversity of variations.  From settings, 
to shaping, to editing, to the Handles menu, let’s explore the basics and beyond, then 
add a few special twists for some fun variations! 

 If working in the Mac version and the steps vary, the specific Mac instructions 

appear in green, beneath or within the corresponding Windows step. 

 

Before We Begin:  Reset All Modules 
Resetting modules before beginning a class or seminar ensures everyone will 
automatically browse to the default folders when opening or saving designs, that all 
toolbars will have the same appearance, and other default settings, such as hoop size and 
orientation, are reset to default. 

 

Tip:  Open PREMIER+™ 2 Configure and Reset All Modules if menus or icons appear 
differently or programs react differently than expected. 

 Open the PREMIER+™ 2 Embroidery desktop program folder . 1.

 In Mac, open Configure  from Launchpad or from a shortcut you have made 

in the Dock. 

 Open PREMIER+™ 2 Configure . 2.
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 In the Utilities tab, click Reset All Modules Reset All Apps .   3.

 In Mac, select Quit Open Premier+™ 2 Apps, then click Reset all Apps.  No other 

steps required, so click Close  

 Click OK in the ‘All modules will be closed’ prompt. 4.

 If any open modules didn’t close, select them in the background and then close 
them. 

 Click OK in the ‘Please confirm’ prompt. 5.

 Click OK in the ‘All modules are now reset’ prompt.   6.

 Click OK to close PREMIER+™ 2 Configure. 7.

 

Begin With a Set of Letters 
The first steps are selecting a Letter Font, and then an Envelope shaping.  We can 

adjust a wealth of additional settings, either before we Apply , or after the 
lettering is in place. 

 Open PREMIER+™ 2 Embroidery  from the Desktop folder or from a shortcut 1.
you’ve created. 

 Open PREMIER+™ 2 Embroidery  from Launchpad  or from a shortcut you 

have created in the Dock. 

 Change Hoop    to Universal, 360mm x 260mm, Orientation Rotated.   2.

 Click OK. 

 Select the Letter tab  in Windows, or the Letter page  in the Control Panel 3.
in Mac. 

 Open the Letter Font Gallery Viewer. 4.
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 Scroll through to review the available fonts in your system. 5.

 Fonts are sub-divided into Categories by similar attributes (such as Applique or 
Children, etc), and listed alphabetically under their category header. 

TIP:  Available Fonts vary according to which system you own.  Embroidery Free has 
no fonts, Embroidery Intro has 12, Embroidery has 175+, and Embroidery Extra 175+ 
and Ultra has 210+. 

QuickFonts , found in Font Manager , uses a Wizard/Assistant to transform 
TrueType® or OpenType® fonts into System Letter Fonts. 

The Import Font from Embroidery  feature, also in Font Manager , has tools 
help you add sets of embroidery letter designs to the Letters System Fonts, so you can 
utilize the Letter functionality to align and arrange them. 

 Scroll to the Fun Category. 6.

 Select Athletic Block UC 15-100mm.   

 Click OK to close the Font Viewer. 

Athletic Block is a single color, upper case font. 

TIP:  System Font names are coded by the Font characteristics.   

The Size Range indicates the optimal size for the letter set characters.  To make 
lettering larger or smaller than the recommended size, you’ll need to make 
adjustments to Density, or Stitch type, to compensate. 

Several other signifiers in the name give pertinent information about the selected 
font.  Here is a snip from the System Help that explains Font information. 
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 Click in the Letters box. 7.

 Type in the word shape. 

All the letters will be upper-case in the Athletic font, so it doesn’t matter whether 
you type them as upper or lower case. 

 Adjust Size to 35mm. 8.

 In Layout, leave Gap at 0, the default spacing between letters in this font. 9.

 Open the Shape menu so you can see all the different Letter Shapes. 10.

 
Shapes are envelopes used to shape the lettering, and come in 35 styles.  A Shape 
can shape all the letters as a single unit, or with the Individual option so each letter 
has its own individual Shape envelope. 

Shape envelopes have handles for adjusting their shaping.  The number and 
placement of handles varies according to the shape. 

Special keyboard keys can lock the shapes aspect or perspective as you adjust their 
handles, and vary according to the shape in use. 

 Select the first Shape, Horizontal Block . 11.

 Click the Shape menu again to close the viewer in Mac. 

Horizontal block is probably the most often used Shape to make text in straight, 
horizontal lines. 

 Uncheck Reverse and Individual. 

 Check ColorSort, so the letters will be sorted down into the fewest possible 
color changes. 

 Click Apply  to place a single word, all in one linear horizontal select box. 

 Check the Control Panel to see the letters all share just one orange color change. 

 Click the Design page  in the Control panel to see the color change, 

then reselect the Letter page . 
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 The select box has four corner handles and a small circle on the right side for 12.
rotating.   

Green handles indicate a Lettering design that has not been closed. 

 A Center of Rotation  locator is in the center of the select box, and can be 
moved to adjust the pivot point on which the select box rotates.  

 Adjust the select box larger or smaller with the corner handles. 13.

 Click and drag a corner (Windows or Mac) to adjust either height or width while 
the diagonally opposing corner is locked in place. 

Click UNDO  (Edit/Undo), or use shortcut keys Control Z (Command Z ) to 
restore the original lettering. 

 Hold the Shift keyboard key (alt/option and Command  in Mac) to adjust 
either height or width while the center is locked in place. 

 Hold the CTRL keyboard key (Shift in Mac) and drag a handle to adjust 
proportionally while the diagonally opposing corner is locked in place.  

 Hold both CTRL and Shift keyboard keys (alt/option and Shift in Mac) to adjust 
proportionally with the center locked in place. 

 Click and drag the first word toward the upper part of the hoop. 14.

 

The following illustrations show Windows and then Mac OS. 
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 Select Pennant Right  in Shape. 15.

 Leave all the other settings the same as you previously used. 

 Click Apply . 

 The letters are all in one select box, one thread 
color, but in a pennant shape. 

The Pennant shape also has four corner handles, but 
the handles can be adjusted independently from 
each other to shape the Pennant. 

Keystroke key combinations work the same as for the Horizontal Line select box. 

 Click and drag the select box beneath the first word. 16.

Selecting different Shapes for sets of Letters helps add emphasis and interest to your 
embroidery! 

 Check Individual in the Shape settings. 17.

  
 Leave all other settings as you used the last time. 
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 Click Apply . 18.

Individual generates each letter in the Letters Box its own individual envelope Shape.  
When you design Lettering using Individual, you can no longer change the properties 
of all those letters at once, as they truly are individual letter select boxes. 

 The letters are now in a temporary Group (indicated by the dashed lines) with 
orange corner handles. 

If you click outside a temporary Group it will disappear, and you would need to 
reselect each of the boxed letters individually to put them into a group again! 

 Inside the Group, each letter has its own Pennant shaped select box. 

 Right click over the select box for the new letters, then select Group from the 19.
alternate pop up menu. 

The select box’s sides are now solid lines, indicating you’ve changed the temporary 
Group to a formal Group.  In a formal Group, when you deselect the design, the 
Group does not disappear, and you can simply click anywhere (or use the 
Tab/Shift+Tab or Command + arrow keys) on that Group again to reselect it. 

 Right click over the Group, and select Restrict Groups from the alternate pop up 20.
menu. 

 When you Restrict the Group, you can then work with the individual parts within 
the group, yet keep them bound together so you don’t have to reselect all the 
pieces to Group again, making them much easier to move or rotate as a unit! 

The Group menu is also found in the Home tab in Windows, and in the Design menu 
in the Mac Menu Bar. 

 Take a little time to play with adjusting the individual letters in the last word you 21.
designed. 

 When done, use the Group menu in the Home tab to select Restrict Groups 
again to close the Group.   

 Click Design in the main menu, and select Restrict Groups to toggle it back off. 

Restrict Groups acts like a toggle to lock or unlock a formal Group. 

 

Change Properties After Applying Lettering 
Properties can be pre-set before you Apply the lettering, or changed afterward as 
long as you do not close the letters (Combine or Fix as Stitches).  When you already 
have a Letter shape select box, it’s easy to change up its properties! 
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Tip:  Combine or Fix as Stitches aren’t required for most designs.  When you work 
with Letters, SuperDesigns, Frames and Decorations, retaining the working quality of 
those elements is quite valuable for future editing.  Because we can use Save or Save 
As to make a working .vp4 file type, reopening designs with Lettering gives us many 
options for changing up text, adding or changing Names, adjusting Density and 
Underlay or even using a different Letter Font! 

Designs are then fixed upon Export so they are ready for your embroidery machine. 

 Use Tab or Shift + Tab to move to the first Horizontal Line select box. 22.

 Use Command key and the left/right keyboard arrow keys move through the 

select boxes. 

 Right click over the work area inside the hoop. 23.

 Select Properties in the alternate pop-up menu. 

  
The Properties menu has options for changing many settings, including the font itself. 
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Properties you can adjust from here include: 

 Open the Font Viewer to select a different Font. 

 Retype the Letters box to change the lettering (great for typos or changing out 
names). 

 Adjust the Size by number or percentage. 

 Change Gap (adjust spacing when using very small or very large lettering) or 
deselect ColorSort. 

 Change Connection Type. 

 Uncheck ColorSort, useful if you want each letter a different color. 

 Change to one of a select list of Shape options. 

 Reverse the letters so they read from right to left, but the individual characters 
are not mirrored. 

 Step (in certain line types like Fit to Line) to adjust the rotation of lettering along 
the baseline. 

 Adjust Alignment and Line Spacing when you have multiple lines or rows of 
lettering. 

 TIP:  If you make changes in this window to try out the properties, just Undo with 
each change to restore your letters to their original settings. 

You can also copy the letter select box, create a new Window (File/New Window or 
File/New in Mac), and practice with settings there, then close the second Window 
when finished with your test run. 

 Cancel the Properties Window. 24.

 Right click in the work area and select Pattern Fill (the stitch type used in this Letter 25.
Font) in the alternate menu. 

TIP:  Each Letter Font is designed with one or more stitch types.  Stitch Types which 
can be edited will appear in the alternate pop-up menu.   

 The Stitch Type settings box (in this Letter Font, it’s Pattern Fill) has adjustments 
specific to Pattern Fill Stitches.   

 In Pattern Fill, you can select a different Fill Pattern, adjust Stitch Angle, Density 
and Underlay, as well as adding Single or Multi Color gradients.   

 Other stitch types may have other settings. For example, a Satin Column font 
will have two styles of Underlay. 
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Some areas may be locked within the system so they can’t be edited, sometimes 
necessary to retain the integrity of the stitches in the Letter Font. 

 Change Density (Constant in Mac) to 35, so we can see the Underlay more closely. 26.

 Click OK. 

 Adjust the view’s Zoom so you can see 
the stitches more closely. 

Density number represents the spacing 
between stitches.   

The lower the Density setting, the closer the stitches.   

The higher the Density setting, the farther apart (more space between) the stitches. 

A high number (low density) allows the fabric and Underlay stitches to show 
through. 

 Right click over the work area and select Pattern Fill in the alternate menu.   27.

 Change Underlay to None.   28.

 Click OK. 

The letter will have no additional support to 
stabilize the fabric when stitching. 

The Pattern Fill still adds ‘travel’ or ‘motion’ 
stitches, buried under the top layer of fill, to move from one section to another, 
determined by the digitizer who designed and executed the System Font file.   

 Right click over the work area and select Pattern Fill in the alternate menu. 29.

 Change Underlay to High.   

 Click OK to view how much heaver the Underlay’s supporting stitches are under 
the top pattern fill. 

 

Some Tips for Adjusting Letters Beyond the Recommended Settings: 

  Letter size and stitch type influence which Density and Underlay settings will best suit 
the font you have selected at any given size. 

  For the System Fonts, the Font’s designer added the correct Density and Underlay to 
stitch the lettering well for the recommended size range. 

  If you plan to make the font much smaller than the smallest recommended size 
range, you will likely find you have too many stitches in the small area, and the 
stitches will appear uneven and clumpy, or distort the fabric.   
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  One solution is to use a finer thread than 40wt to stitch.  However, you might not 
have finer thread, or have the color you want to use. 

  Another is to make the design less dense by raising the Density setting one or two 
numbers.   

  In some letter styles, you might also need to raise or lower the amount of Underlay to 
adjust how the fabric is secured to support the stitches placed on top. 

  When designing letters that are much larger than the maximum recommended size, 
you will often need to use both lower Density number (more dense) and higher 
Underlay to give better coverage and more support. 

  Whether you are making the letters much larger or much smaller than the 
recommended size range, it’s always a good idea to make a small sample of the 
letters to test your new settings before stitching a final project. 

 

 Right click over the work area and select Pattern Fill in the alternate menu. 30.

 Open the Pattern Gallery Viewer. 

   
 Select a new Pattern Fill of your choice from the Gallery viewer. 

 Click the Pattern Fill preview again to close the Pattern Fill Gallery Viewer. 

 Adjust Underlay to Medium. 

 Adjust Density (Constant in Mac) to 2, to give good coverage for this Size 35 
lettering. 

 Click OK. 

 Use Life View  to preview how the letters look with your new pattern. 31.

 Click Cancel (Close in Mac) to close Life View. 
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 Run the Design Player   to view how the stitches for Underlay are placed, 32.
and how they stitch over the top. 

 Click Cancel (Close) when done viewing. 

 

Gradient Fills 

The Help system has an excellent explanation of working with Gradient Fills. 

To access the specific help pages quickly while in the Pattern Fill properties box, in 
Windows, click Help in the Properties box.  Select Pattern Fills in Help, and then 
Density.   

For Mac, enable the Gradient option, open the Gradient settings menu  , and 

then open Help  from the Gradient properties box. 

   
 

Changing Letter Fonts and Envelope Shape in Properties 
Let’s review the menus for changing up Letter Fonts and Envelope Shapes using the 
Properties from the alternate menu, after the letters are Applied. 

 Select the pennant shaped set of lettering using one of the methods below. 1.

 Click on the letters to select them. 

 Tab or Shift + Tab until the select box surrounds the pennant shape. 

 Hold the Command key and use the right or left keyboard arrows to step 

through the designs. 
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 Right click over the work area and select Properties in the alternate menu. 2.

 Open the Font Gallery Viewer to select a new font. 3.

   
 In the Fun Category, select Bell UC 20-100mm. 

 In Mac, click OK. 

 Open the Shape menu, and select Fit to Straight Line. 4.

 Select Step. 

 Click OK. 5.

 Click and drag the letters up a bit in the work area so 6.
you can play with the adjustments. 

The Step function is used with Fit to Straight Line and 
Fit to Wavy Line. 

Step allows you to set the letters in stair-steps while 
keeping them aligned with the angle of the baseline. 

 Adjust the Base Line angle with the round 
handle.  The bottoms of the letters will remain 
parallel with the angle of the base line. 

 Adjust the Step Line to turn the lettering into stair-steps.   

Their base will stay aligned with the angle you set in the Base Line. 

 Adjust the Base Line as shown (round handle to your right, horizontal). 

 Drag the Step Line handle to different angles to see how the lettering changes. 

 Select the third set of letters, which are a Group with 5 individual letters. 7.

 Right click over the work area to open the alternate menu. 

 Open Properties. 
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Because a Group is selected, you can only adjust the size by percentage, or rotate. 

To make other changes, you would need to Restrict Groups or Ungroup first, then 
adjust each letter individually. 

 Click Cancel to close the Properties box. 

 

Don’t forget the Help system when you’re working with unfamiliar Shape Envelopes 
and their properties!  Each Envelope Shape is clearly explained in the Letters section 
of Help, and in the User and Resource guides. 

 

Handles Menu 

The Handles menu  is a fabulous feature that gives great artistic functionality to 
the lettering options!  The Handles menu is opened from a ‘handle’ icon attached to 
the upper left corner of the letter shape’s select box, or from the right-click alternate 
menu. 

Let’s play a bit with Handles to grow our familiarity with just how many options they 
offer. 

 Open a new Program window. 1.

 File / New Window. 

 File / New. 

 Change Hoop    to Universal, 360mm x 260mm, Orientation Rotated.   2.

 Click OK. 

 Select the Letter tab  in Windows, or the Letter page  in the Control Panel 3.
in Mac. 
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 Open the Letter Font Gallery Viewer. 4.

 
 Browse to the Modern Category. 5.

 Select Bremen UC 15-60mm. 

 Click OK in Mac. 

 Change Size to 35. 

 Type handles in the Letters Box. 

 Click Apply . 

The Handles menu  is on the upper left corner of the lettering select box. 

The Handles menu also appears in the right-click alternate pop-up menu. 

 Click the icon  on the select box to open the Handles menu. 6.

   
The Handles menu is divided into sections. 

 The first section offers some basic envelope shapes.  When Curve is the 
selected shape, you can add or remove points to the curve. 

 The next section has choices to either Match Top and Bottom Lines (default), or 
making a different top and bottom Line shaping. 

 The Constraint tools let you unlock the shape for the named constraint.   

 Force Even Distribution can ‘even out’ the distribution of multiple points placed 
between two end points. 
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 Select Diamond. 7.

The Match Top and Bottom feature was checked on by default, so both the top and 
bottom of the lettering shape become a diamond. 

 Click the Handles menu .   8.

 Click Match Top and Bottom to toggle it off (highlight will disappear). 

 Click the Handles menu . 9.

 Select Bottom Line Type. 

The options for the Bottom menu are now active. 

   
 Select Arch. 

Using different Top and Bottom line types can give interesting options to your letter’s 
shaping. 

 Click the Handles menu . 10.

 Change the Bottom Line Type to Curve. 

 Click the Handles menu . 11.

 Select Bottom Line Type. 

You can now Add 1 or 3 points to the curve to do some creative shaping, or remove 
one point at a time. 

 Click Add 3 points to curve. 

 Click and drag some of the new points to readjust the bottom shaping. 12.

The points are locked into an even distribution along the curved line because Force 
Even Distribution was selected. 
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 Click the Handles menu . 13.

 Click Force Even Distribution to toggle it off. 

 Click and drag any of the handles in the bottom line to reshape and freeform the 
curved bottom. 

 Click the Handles menu . 14.

 Select Constraint - Free. 

The handles at the ends of the top or 
bottom line are no longer constrained 
by their shape, and can be adjusted 
freely. 

Are you visualizing some cool things 
you could do with the Handles?  How 
about shaping this into a bird, or an 
airplane? 

And of course, we have other 
Constraint selections, too. 

 Click the Handles menu . 15.

 Select Constraint - Size. 

 Adjust the corner handles on the select box to see how the handles are locked to 
each other. 

 

Here is a snippet from Help that explains 
each of the Constraint Handle options. 

The Constraint – Free option is a powerful 
tool, and gives great flexibility for playing 
with letter shaping, skewing, twisting and 
designing different art forms! 
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Here is a quick sampler lesson to get you thinking outside the box (pun intended) with 
Letters! 

 

Home Sweet Home Sampler  
 Open a new Program window. 1.

 File / New Window. 

 File / New. 

 Change Hoop    to Enter Hoop Size. 2.

 Change Width and Height to 260mm. 

 Click OK. 

 Select the Letter tab  in Windows, or the Letter page  in the Control Panel 3.
in Mac. 

 Open the Letter Font Gallery Viewer. 4.

 
 Browse to the Retro Category. 

 Select Jingo 25-55mm. 

 Click OK. 

 Type HOME in the Letters box. 

 Change Size to 40mm. 

 In Shape, select Circle Clockwise . 

 Click the Shape menu again to close the viewer. 

 In Stitch Type, select Satin Column, and then change to Pattern 115. 

 Click OK. 
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 Click Apply . 5.

The letters are in a clockwise circular base, centered in the hoop. 

The green handle locates the letters along the baseline and resizes the diameter of 
the baseline. 

When you want to keep the baseline circle the same size as you 
move the letters around the circle, hold down the Control key (Shift 
key in Mac). 

 Click and drag the green handle up along the vertical grid to make 6.
the letter circle larger but leave one grid empty at the top of 
thehoop. 

 Change the Line Shape to Circle Counterclockwise . 7.

 Click Apply .  The lettering is offset from the first. 

 Cursor over the baseline circle’s center to get the Move cursor . 

 Click and drag the letters down until the top of the baseline sits just under the 
first set of letters. 

 Adjust the baseline larger by 
dragging the green corner handle 
down the vertical gridline, then 
move the lettering down as needed, 
until the top and bottom words are 
balanced. 

The baseline circle in the second set of 
letters should be roughly the same 
curvature as the first set of letters. 

 Highlight and delete the letters in the 8.
Letters Box. 

 Type in SWEET. 9.

 Select Diamond  in Letter Shapes. 

 Click Apply . 
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 Click the Handles menu  on the new lettering (sweet). 10.

 Click Match Top and Bottom Lines to toggle off. 

 Click the Handles menu . 11.

 Change the Top to Curve. 

 Click the Handles menu . 12.

 Select Add Point to Curve, so the top curve has three points between the ends. 

 Click the Handles menu . 13.

 Click Bottom Line Type. 

 Select Diamond. 

 Adjust the handles until Sweet is roughly formed into a heart shape. 14.

Just for fun, finish it off with a Frame! 

 Select all the designs. 15.

 In Windows, shortcut with Control + A. 

 In Mac, shortcut with Command  + A. 

 Right click to open the alternate pop-up menu. 16.

 Select Group. 

 Select the Frame tab/page . 17.

 Select Frame in Category. 

 Select Frames in Type . 

 Select Classical 1 Category, and Frame 4. 

 Set Margin at 2.5mm. 

 Group should be checked, so the Frame will be grouped to the letter elements 
when complete, inhibiting accidental realignment. 

 In Stitch Type / Satin Line options , change Width to 2mm, and adjust 
Density to 5 (not quite as dense for a very narrow stitch). 

 Click OK to close Satin Line Options. 



  Page 21 of 21 

PREMIER+ is a trademark of KSIN Luxembourg II, S.ar.l.  All trademarks are used under license by VSM Group 
AB. © 2020 KSIN Luxembourg II, S.a.r.l 

Double check to make sure the Group has a select box, or the frame will jump to the 
hoop. 

 Click Apply . 18.

 Change the thread colors as desired in the Control Panel (Design page  in 19.
Control Panel in Mac).  

 Select Save As  to save an un-finalized working file as a .vp4. 20.

 File / Save As, or Actions menu (Hold alt/options key) and Save As. 

 Select Export  to finalize the design for embroidery using the correct format for 21.
your embroidery machine. 

 File / Export, or Actions menu  and Export. 

 Use mySewnet   functionality if you have one of the compatible wi-fi 22.
connected embroidery machines. 

 

Although it’s nearly impossible to cover every nuance in the Letters tab/page in one 
sitting, the topics in the lesson today should give you greater familiarity with how 
lettering basics work, as well as some of the more artistic and flexible options and 
where they are found in PREMIER+™ 2 Embroidery. 

Remember to consult the Resource and User Guides (included in the PREMIER+™ 2 
Embroidery system folder under Guides), or the Help system, when learning new 
techniques, or for refreshing when you feel a little rusty! 

Have a little fun, and make something new, as you express yourself with words in a 
whole new shape and form. 

You’ve got a handle on it! 


